CHAPTER 7

Resource Library

Using the Resource Library

On this tab you find an assortment of resources to help you learn more about Cisco Unified
Communications.

¢ Cisco Unified Communications System Description

e Cisco Unified Communications System Release Notes
e Network Topology Resources

e Ordering Guides for Cisco Partners and Employees

¢ Troubleshooting Individual Components

e Component Resources

¢ Configuration Command Files

e System Test Results

e End-of-Sale and End-of-Life

e Cisco Unified Communications System Demo

Cisco Unified Communications System Description

For Release 5.1(1):

Cisco Unified Communications System Description (right-click to download PDF)

Cisco Unified Communications System Release Notes

System Release Notes for IP Telephony: Cisco Unified Communications System, Release 5.1(1)

Network Topology Resources

This topic provides topology resources that you can use to document network plans. Specifically, it
includes:

e Microsoft Visio Network Topology Diagrams as individual Microsoft Visio files
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e How to Use Microsoft Visio Drawings Efficiently, guidelines for best practices in using Microsoft

Visio files

Microsoft Visio Network Topology Diagrams

You can download zip files containing Visio drawings of the logical and physical topologies for IP
telephony. Table 1 identifies the Visio drawings in each zip file.

~

Note  You need Microsoft Visio 2003 to open the files.

If you need to create new Visio drawings, you can use the Cisco Visio stencils located at the Visio

Stencils resource page.

Table 1 Microsoft Visio Topology Diagrams

Description

Filename

Zip file includes the site model topology drawings
listed below.

IPT_SiteModels.zip (right-click to download zip)
5.7 MB

Note If youclick the link rather than right-click,

the zip file may open in the secondary
window but also replace the contents of
this window. Use your Back button to
return to this window.

All test sites in North America Multisite
Distributed deployment

SiteModel_NorthAmerica_All.vsd

Very Large Campus Clustering over the WAN
(SJC-RFD) site model

SiteModel_LargeCampus_SJCRFD.vsd

Multi-Site Centralized, Clustering over the
WAN with Unified SRST (SFO-ORD) site
model

SiteModel_MultiCentralized_SFOORD.vsd

Large SIP Site (DFW) site model

SiteModel_LargeSIP_DFW.vsd

Small-Campus H.323 Site (YYZ) site model

SiteModel_SmallH323_YYZ.vsd

Small-Campus SIP Site (ATL) site model

SiteModel_SmallSIP_ATL.vsd

Non-Cisco CallManager Interoperability Site
(HNL) site model

SiteModel_NonCallManagerInterop_HNL.vs
d

Cisco CallManager Interoperability Site
(NYC) site model

SiteModel_CallManagerInterop_NYC.vsd

Medium Site (RDU) site model

SiteModel_MediumSite_ RDU.vsd

Small Site (RXB) site model

SiteModel_SmallSite_ RXB.vsd

All test sites in Europe and Emerging Markets
(EUEM) Multisite Distributed deployment

SiteModel EUEM_AIll.vsd

EUEM Cisco Unified CallManager
Interoperability Site (LGW) site model

SiteModel_EUEM_CallManagerinterop_LG
W.vsd

EUEM Medium Site (GVA) site model

SiteModel EUEM_MediumSite_ GVA.vsd
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http://www.cisco.com/en/US/products/prod_visio_icon_list.html
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Microsoft Visio Topology Diagrams (continued)

Description

Filename

EUEM Large Multisite Centralized with
Unified SRST (CDG) site model

SiteModel_EUEM_MultiCentral_CDG.vsd

EUEM Small Campus Multisite H.323
(WAW) site model

SiteModel EUEM_MultiH323_ WAW.vsd

EUEM Non-Cisco Unified CallManager
Interoperability Site (RKV) Site model

SiteModel _EUEM_SIPSite. RKV.vsd

EUEM Small Site (MAD) site model

SiteModel _EUEM_SmallSite_ MAD.vsd

Zip file includes component topology drawings
listed below.

IPT_Components.zip (right-click to download

zip)
Note

5.2 MB

If you click the link rather than right-click,
the zip file may open in the secondary
window but also replace the contents of
this window. Use your Back button to
return to this window.

Cisco Unified CallManager Express and
Cisco Unity Express test topology

CME_CUE_Site_Topology.vsd

Cisco IP Video Telephony topology

IPVideo_OverallTopology.vsd

Multisite Centralized video deployment using
Cisco IP Video Telephony PSTN gateway

IPVideo_MultiCentralized_ EUEM.vsd

Basic video deployment with Cisco RSVP
Agent

IPVideo_WithRSVP.vsd

Cisco Unified MeetingPlace Topology in
Multisite Distributed Deployment

MeetingPlace_Topology.vsd

QSIG connections to Cisco Unified
CallManager clusters

QSIG_CallManager_Clusters.vsd

QSIG connections to Cisco Unified
CallManager Express sites

QSIG_CallManager_Express.vsd

Cisco Unity logical topology

Unity_Logical_Topology.vsd

Cisco Unity and Unity Connection physical
topology - North America

Unity_NA_Site_Topology.vsd

Cisco Unity setup in EUEM test environment

Unity EUEM_Site_Topology.vsd

Cisco Unified CallManager Express
integrated with Cisco IP-to-IP Gateways

CME_IP-IP_Gateways.vsd

Security test topology using Cisco Catalyst
Firewall Security Module (FWSM)

SecurityTopology_ FWSM.vsd

Security test topology using Cisco Secure PIX
Firewalls

SecurityTopology_PIX.vsd

Cisco Unity Connection test topology for
Unified CallManager and Unified
CallManager Express multisite integration

UnityConnection_MultIntegration.vsd
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How to Use Microsoft Visio Drawings Efficiently

Microsoft Visio allows you to bring drawings into several applications (for example, Microsoft Word,
Powerpoint). Unfortunately, the default method is to insert the whole “Visio object” into a file. This can
cause problems.

When you copy and paste a Visio drawing into another application, the Visio object includes all the
application data with the drawing. This object information is needed if you want to be able to
double-click the drawing from Word or Powerpoint and have it open up in Visio for editing. But pasting
as an object adds many megabytes to the size of your file. With only a few such drawings, a Word
document can bloat from 300 KB to 12 MB, making it troublesome to share among authors or reviewers,
and a trial for partners or customers to download. (They might even give up before it is done.) In
addition, very large documents are more problem-prone.

Bringing a Visio Drawing into a Document

Step 1
Step 2

Step 3

Unless you really need the live editing capability, avoid unnecessary file bloat by performing an extra
step when you paste:

In Visio, copy the drawing as you normally do. Tip: Ctrl-C copies the whole drawing.

At the desired location in the destination document, choose Edit > Paste Special. In the Paste Special
dialog box, choose Picture (Windows Metafile).

Source:  Wisio 2000 Dravang
C:\Documents and SettingsihweisertiMy D..
= Cancel
(%) Paske: Wisio 2000 Drawing Object
™ el Picture (Windov:s Metafile:
e ke Picture (Enhandal Metafile)
Result

Inserts the contents of the Clipboard as & windows
metafile picture,

Click OK. The drawing pastes as an ordinary picture. If it is not positioned properly, choose Format >
Picture, click the Layout tab and select In line with text. This is generally the most reliable layout
option.

The Bottom Line
Do not use the paste default (Edit > Paste or Ctrl-V) to paste Visio drawings. Always use Paste Special.

Cisco Unified Communications System for IP Telephony Release 5.1(1)
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Ordering Guides for Cisco Partners and Employees ||

Downsizing Existing Drawings

Step 1

Step 2

Tip

If a document is larger than it should be, you can check to see if the Visio drawings are the reason and,
if so, fix the problem.

With the drawing selected in the Word or Powerpoint document, choose Edit. At the bottom of the Edit
menu, you will see one of the following:

e Edit Object, if the drawing was inserted by simple pasting. It is a Visio object and taking up much
more file space than it needs to. Go on to step 2.

e Edit Picture, if the drawing was inserted properly, as a picture. It is not the source of the large file
size.

If the drawing is an object, cut it (Ctrl-X), then repaste it as in Bringing a Visio Drawing into a
Document.

You can easily click through the document to check each picture by using Word's handy Go To feature:
Where you want to start searching, press Ctrl-G. In the Go to what list, select Graphic and click Next.
You go to the next graphic. Click it to select, and then check as in step 1. If needed, repaste as in step 2.
Click Next and continue these steps for other graphics.

Ordering Guides for Cisco Partners and Employees

~

Note

Ordering guides for most Cisco Unified Communications products are available for Cisco partners and
employees.

Some of these guides require software to open, such as Microsoft Powerpoint or Adobe Acrobat Reader.
You can also right-click on these files and select Save Target As to download them to your desktop.

Software Bundles
e Unified Communications Solution Bundle (Powerpoint) (INTERNAL)

Call Control, End Points, and Call Control Applications
e Cisco Unified CallManager 5.0 (Powerpoint) (INTERNAL)

e Cisco Unified IP Phones (Powerpoint)(INTERNAL)
e Cisco CallManager Express (%
¢ Cisco Unified Survivable Remote Site Telephony (SRST) (&'

Contact Center

e Cisco Customer Contact Center Business Unit Price List (PDF)—This list addresses pricing and
packaging structure for all Contact Center products.

Conferencing
e Cisco Unified MeetingPlace (PDF) (INTERNAL)

Cisco Unified Communications System for IP Telephony Release 5.1(1) g


http://wwwin.cisco.com/voice/presentations/ppt/solutionbundle_pricingordering.ppt
http://wwwin.cisco.com/voice/presentations/ppt/cm50_pricingordering.ppt
http://wwwin.cisco.com/voice/presentations/ppt/ipphones_pricingordering.ppt
http://www.cisco.com/en/US/partner/products/sw/voicesw/ps4625/products_qanda_item0900aecd800cc522.shtml
http://www.cisco.com/en/US/partner/products/sw/voicesw/ps2169/products_qanda_item0900aecd8028d122.shtml
http://www.cisco.com/application/pdf/en/us/partner/products/ps1844/c1758/ccmigration_09186a00801aee46.pdf
http://wwwin.cisco.com/voice/doc/mp_ordering.pdf
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¢ Cisco Unified MeetingPlace Express (PDF)

Messaging
e Cisco Unity (PDF)
e Cisco Unity Connection (PDF)

Troubleshooting Individual Components

See the table IP Telephony Component Troubleshooting Tools and Documentation on the Implement tab
for individual component troubleshooting information.

Component Resources

The following list contains links to the main page for documentation on various for the Cisco Unified
Communications components; from here you can navigate to individual documents. For documentation
on specific tasks, see Component Installation and Tested Component Configurations on the Implement
tab.

Voice and Unified Communication Documentation

http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html

Cisco Unified CallManager
http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html

Cisco Unified Presence Server
http://www.cisco.com/en/US/products/ps6837/tsd_products_support_series_home.html

Cisco Unity Connection

http://www.cisco.com/en/US/products/ps6509/tsd_products_support_series_home.html

Customer Response Solutions
http://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products_support_series_home.html

Cisco Emergency Responder

http://www.cisco.com/en/US/products/sw/voicesw/ps842/tsd_products_support_series_home.html

Cisco Unity
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/tsd_products_support_series_home.html

Cisco Unified MeetingPlace
http://www.cisco.com/en/US/products/sw/ps5664/ps5669/tsd_products_support_series_home.html

Cisco Unified CallManager Express

http://www.cisco.com/en/US/products/sw/voicesw/ps4625/tsd_products_support_series_home.html

Cisco Unified Communications System for IP Telephony Release 5.1(1)
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http://www.cisco.com/web/partners/downloads/partner/WWChannels/technology/ipc/downloads/mpe_priceguide.pdf
http://www.cisco.com/web/partners/downloads/partner/WWChannels/technology/ipc/downloads/unity4_pricing.pdf
http://www.cisco.com/web/partners/downloads/partner/WWChannels/technology/ipc/downloads/unity_cxn_pricing_ordering.pdf
http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6837/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6509/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1844/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps842/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/ps5664/ps5669/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps4625/tsd_products_support_series_home.html
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Cisco Unity Express
http://www.cisco.com/en/US/products/sw/voicesw/ps5520/tsd_products_support_series_home.html

Cisco Unity Connection
http://www.cisco.com/en/US/products/ps6509/tsd_products_support_series_home.html

Customer Response Solutions

http://www.cisco.com/en/US/products/sw/custcosw/ps1846/tsd_products_support_series_home.html

Cisco Unified MeetingPlace Express
http://www.cisco.com/en/US/products/ps6533/tsd_products_support_series_home.html

Cisco Unified Survivable Remote Site Telephony (SRST)

http://www.cisco.com/en/US/products/sw/voicesw/ps2169/tsd_products_support_series_home.html

Cisco Unified Videoconferencing Products
http://www.cisco.com/en/US/products/hw/video/ps1870/tsd_products_support_series_home.html

Cisco 2600 Series Routers

http://www.cisco.com/en/US/products/hw/routers/ps259/tsd_products_support_series_home.html

Cisco 2800 Series Routers/Voice Gateways

http://www.cisco.com/en/US/products/ps5854/tsd_products_support_series_home.html

Cisco 3700 Series Voice Gateways/Gatekeepers
http://www.cisco.com/en/US/products/hw/routers/ps282/tsd_products_support_series_home.html

Cisco 7200 Series Voice Gateways

http://www.cisco.com/en/US/products/hw/routers/ps341/tsd_products_support_series_home.html

Cisco Catalyst 3550 Series Access Switches
http://www.cisco.com/en/US/products/hw/switches/ps646/tsd_products_support_series_home.html

Cisco Catalyst 3560 Series Access Switches
http://www.cisco.com/en/US/products/hw/switches/ps5528/tsd_products_support_series_home.html

Cisco Catalyst 3750 Series Data Center Switches
http://www.cisco.com/en/US/products/hw/switches/ps5023/tsd_products_support_series_home.html

Cisco Catalyst 6500 Series Switches
http://www.cisco.com/en/US/products/hw/switches/ps708/tsd_products_support_series_home.html

Cisco VG224/248 Analog Voice Gateways
http://www.cisco.com/en/US/products/hw/gatecont/ps2250/tsd_products_support_series_home.html

Cisco ATA 186/188 Analog Telephone Adaptors
http://www.cisco.com/en/US/products/hw/gatecont/ps514/tsd_products_support_series_home.html
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http://www.cisco.com/en/US/products/sw/voicesw/ps4625/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/voicesw/ps5520/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6509/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/custcosw/ps1844/tsd_products_support_series_home.html
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http://www.cisco.com/en/US/products/sw/voicesw/ps2169/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/video/ps1870/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/routers/ps259/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps5854/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/routers/ps282/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/routers/ps341/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/switches/ps646/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/switches/ps5528/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/switches/ps5023/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/switches/ps708/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/gatecont/ps2250/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/gatecont/ps514/tsd_products_support_series_home.html
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Cisco Security Agents
http://www.cisco.com/en/US/products/sw/secursw/ps5057/tsd_products_support_series_home.html

Cisco Fax Server
http://www.cisco.com/en/US/products/ps6178/tsd_products_support_series_home.html

Cisco Secure PIX Firewall Servers
http://www.cisco.com/en/US/products/hw/vpndevc/ps2030/tsd_products_support_series_home.html

Cisco SIP Proxy Server
http://www.cisco.com/en/US/products/sw/voicesw/ps2157/tsd_products_support_series_home.html

Cisco Unified Operations Manager
http://www.cisco.com/en/US/products/ps6535/tsd_products_support_series_home.html

Cisco Unified Service Monitor
http://www.cisco.com/en/US/products/ps6536/tsd_products_support_series_home.html

CiscoWorks Resource Manager Essentials

http://www.cisco.com/en/US/products/sw/cscowork/ps2073/tsd_products_support_series_home.html

Cisco Unified IP Phones

http://www.cisco.com/en/US/products/sw/voicesw/tsd_products_support_category_home.html

Cisco Unified Video Advantage
http://www.cisco.com/en/US/products/sw/voicesw/ps5662/tsd_products_support_series_home.html

Cisco IP Communicator

http://www.cisco.com/en/US/products/sw/voicesw/ps5475/tsd_products_support_series_home.html

Cisco Unified Personal Communicator
http://www.cisco.com/en/US/products/ps6844/tsd_products_support_series_home.html

Cisco Aironet 1200 Series Access Points

http://www.cisco.com/en/US/products/hw/wireless/ps430/tsd_products_support_series_home.html

Cisco Unified Mobility Manager
http://www.cisco.com/en/US/products/ps6567/tsd_products_support_series_home.html

Cisco 10S Software Releases 12.4 T
http://www.cisco.com/en/US/products/ps6441/tsd_products_support_series_home.html

Configuration Command Files

l_ Cisco Unified Communications System for IP Telephony Release 5.1(1)

You can download sample configuration files from this table for the components described in the Tested
Component Configurations topic in the Implement tab.



http://www.cisco.com/en/US/products/hw/gatecont/ps514/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/sw/secursw/ps5057/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6178/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/hw/vpndevc/ps2030/tsd_products_support_series_home.html
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http://www.cisco.com/en/US/products/sw/voicesw/ps5475/tsd_products_support_series_home.html
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http://www.cisco.com/en/US/products/hw/wireless/ps430/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6567/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6441/tsd_products_support_series_home.html
http://www.cisco.com/en/US/products/ps6536/tsd_products_support_series_home.html
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Table 2

Sample Component Configuration Files

Configuration Command Files

Description

Filename

Zip file includes Cisco device configurations listed
below:

Note

Some parameters, such as passwords, have
been removed from the configuration files for
security reasons.

Note

IPT_Tested_Configs.zip (right-click to
download zip) includes the files below.

If you click the link rather than
right-click, the zip file may open in the
secondary window but also replace the
contents of this window. Use your
Back button to return to this window.

Cisco Unified CallManager Express on a Cisco
2611 (ALT-CME-2611-4)

CME_2611_Config.txt

Cisco Unified CallManager Express on a Cisco
2651 (YYZ-CME-2651-2)

CME_2651_Config.txt

Cisco Unified CallManager Express on a Cisco
2691 (ALT-CME-2691-2)

CME_2691_Config.txt

Cisco Unified CallManager Express on a Cisco
2821 (WAW-2821-CMES)

CME_2821_Config.txt

Cisco Unified CallManager Express on a Cisco
3745 (YYZ-CME-3745-1)

CME_3745_Config.txt

Cisco Unified CallManager Express on a Cisco
3845 (ALT-CME-3845-3)

CME_3845_Config.txt

Cisco Unity Express on a Cisco 3745
(YYZ-CUE-3745)

CUE_3745_Config.txt

Cisco Catalyst switch Firewall Service Module
(SJC-RFD-FWSM-1)

FWSM_Config.txt

Cisco 3745 primary gatekeeper (SJC-RFD-GK-1)

Gatekeeper_Primary_Config.txt

Cisco 3745 alternate gatekeeper
(SJC-RFD-GK-2)

Gatekeeper_Alternate_Config.txt

Gatekeeper configured as first gatekeeper in a
cluster ( SJC-RFD-VID-GK-1)

Gatekeeper_FirstinCluster_Config.txt

Gatekeeper configured as second gatekeeper in a
cluster (SJC-VIDEO-GK-2)

Gatekeeper_SecondinCluster_Config.txt

Cisco 3845 H.323 gateway (SJC-RFD-3845GW)

H323GW_3845_Config.txt

Cisco 3725 MGCP gateway
(SJC-RFD-3725-GW2)

MGCPGW_3725_Config.txt

Cisco 3745 SIP gateway (DFW-3745GW)

SIPGW_3745_Config.txt

Cisco Unified MeetingPlace Audio Server
MP-8112 (SJC-RFD-MP-1) license summary

MeetingPlace_License.txt

Cisco Secure PIX Firewall (DFW-PIX-1)

PIX_Firewall_Config.txt

Cisco RSVP Agent configured for video
deployment

RSVPAgent_Video_ConfigExcerp.txt

Cisco RSVP Agent on a Cisco 2821
(DFW-2-2821)

RSVPAgent_2821_Config.txt

Cisco Unified Communications System for IP Telephony Release 5.1(1) g
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Table 2

Sample Component Configuration Files (continued)

Description

Filename

QoS configured on a Cisco 3745
(SFO-ORD-104-3745)

QoS_3745_ConfigExcerp.txt

QoS configured on a Cisco Catalyst 4506
(SFO-ORD-45006)

QoS_4506_ConfigExcerp.txt

QoS configured on a Cisco Catalyst 7200
(SFO-ORD-WAN-1)

QoS_7200_ConfigExcerp.txt

Cisco Catalyst 6500 switch (CDG_CMM-GW_1)
configured for QSIG links

QSIG_Cat6500_Config.txt

Cisco 2801 configured as SIP MWI Client
(YYZ-CME-2801-6)

SIP_MWI_Client_2801.txt

Cisco 2851 configured as SIP MWI Relay
Server(YYZ-CME-2851-5)

SIP_MWI_Relay_2851.txt

Cisco Unified SRST for H.323 on a Cisco 2691
(HNL1-WAN-2691)

SRST_H323_HNL1_Config.txt

Cisco Unified SRST for MGCP on a Cisco 2691
(HNL2-SRST-2691)

SRST_MGCP_HNL2_Config.txt

Cisco Unified SRST for SIP on a Cisco 2821
(DFW-2-2821)

SRST_SIP_Remote2821_Config.txt

Cisco Unified SRST for SIP on a Cisco 3845
(DFW-REMOTE-3845)

SRST_SIP_Remote3845_Config.txtg

Cisco Aironet 1200 Access Point (AP)

Wireless_AironetAP1200_Config.txt

Cisco Access Control Server for LEAP

Wireless_ ACS_LEAP_Config.txt

System Test Results

Testing Objectives
Tested Deployment and Site Models
Test Results

Testing Objectives

This topic summarizes the results of Cisco Unified Communications Release 5.1(1) system testing for
IP telephony environments. This topic contains the following sections:

Cisco Systems validates Cisco Unified Communications systems by designing, installing, configuring,
and testing hardware and software to achieve a predictable, effective, and reliable system. The intent of
system testing is to validate the seamless interoperability and stability of the components that make up
a complete and optimized Cisco Unified Communications system.

Testing performed for Cisco Unified Communications includes (but is not limited to) the following:

Installation, Upgrade, and Usability Testing—To verify software installation and upgrades at the

system level and usability for system components

l_ Cisco Unified Communications System for IP Telephony Release 5.1(1)
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¢ End-to-End Functionality Testing—To verify the end-to-end functionality of system components
e Basic Functionality and Feature Testing—To verify basic call flows and component features

e Customer Assurance Program (CAP) Scenario Testing—To re-create and test CAP scenarios based
on TAC input

¢ Interoperability Testing—To verify the interoperability among system components
e Scalability Testing—To verify system functionality during scalability tests

e Performance, Load, and Stress Testing—To verify system functionality during performance, load,
and stress tests

e Failover, Recovery, and Redundancy Testing—To verify system behavior during failover and
recovery, and behavior in redundant configurations

Tested Deployment and Site Models

Test Results

Cisco Unified Communications Release 5.1(1) testing for IP telephony was designed to test the hardware
and software components that work together in a multi-site distributed IP telephony deployment. For this
testing, several site models were created. Each site model was designed to test a specific set of features
and interactions. For information about the components, configurations, and environment tested in Cisco
Unified Communications Release 5.1(1), see Tested Deployments and Site Models.

The results of the system tests performed for IP telephony during Cisco Unified Communications
Release 5.1(1) are shown in the System Test Results (right-click to download PDF).

The test results contain the following information:

e Title—Title of the test.

e [D—Identifier for the test.

¢ Description—Description of the purpose of the test.

e Features Tested—Component feature tested.

e Status—Result of the test and any defects related to the test case. Possible values are:
— Passed—Test case passed as described in the table.
— Failed—Test case failed and the reason is described in the listed defect.

— Passed with exception—Test case as described passed but an anomaly occurred that was not
directly related to the functionality being tested. Possible anomalies are as follows:

The test steps were modified based on the actual feature implementation.
The test setup was modified based on the actual feature implementation.

The test results did not exactly match what was expected although the feature performed as
required.

e Defects—Identifier for any defect that was opened against the test. If you have an account with
Cisco.com, you can use the Bug Toolkit to view information about defects.

To access the Bug Toolkit, go to this URL:
— http://www.cisco.com/cgi-bin/Support/Bugtool/launch_bugtool.pl 3

Cisco Unified Communications System for IP Telephony Release 5.1(1) g


http://www.cisco.com/univercd/cc/td/doc/systems/unified/uc511/starmipt/stiptmod.htm
http://www.cisco.com/univercd/cc/td/doc/systems/unified/uc511/results/tript511.pdf
http://www.cisco.com/cgi-bin/Support/Bugtool/launch_bugtool.pl

Chapter7  Resource Library |

End-of-Sale and End-of-Life

End-of-Sale and End-of-Life

The end-of-sale (EOS) date is the last date to order the product through Cisco point-of-sale mechanisms.
The product is no longer for sale. There is also an end-of-life (EOL) process that guides the final business
operations associated with the product life cycle.

The EOL process consists of a series of technical and business milestones and activities that, once
completed, make a product obsolete. Once obsolete, the product is not sold, manufactured, improved,
repaired, maintained, or supported.

For information about recommended replacements, see the comprehensive list of announcements at the
following URL:

http://www.cisco.com/en/US/products/prod_end_of_life.html

For information on specific products, choose a product from the following URL:
http://www.cisco.com/en/US/products/sw/voicesw/index.html

Then click on the End-of-Life and End-of-Sale Notices link in the Product Literature box.

For an overview of the Products and Services EOL policy, see the information at the following URL:

http://www.cisco.com/en/US/products/products_end-of-life_policy.html

Cisco Unified Communications System Demo

The Cisco Unified Communications system demonstration document is for Cisco sales teams and
describes the various methods available to demonstrate the Cisco Unified Communications System.

e Cisco Unified Communications System Demo (INTERNAL)

Cisco Unified Communications System for IP Telephony Release 5.1(1)
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